Introduction

This release note contains information about the release 4.3.12 of the ST Visual Develop integrated development environment, available for the STM8 (STVD-STM8) and ST7 (STVD-ST7) microcontrollers.

This release note is updated periodically to keep the user abreast of the software evolutions and of any problems or limitations found. The latest version of this release note is available at the www.st.com website. Refer to Table 1 for the latest release summary.

Table 1. STVD 4.3.12 release summary

<table>
<thead>
<tr>
<th>Type</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>New features</td>
<td>Added support for STM8L152K8 and STM8S001J3 microcontrollers on Simulator and Swim debug instruments.</td>
</tr>
</tbody>
</table>

Customer support

For more information or help concerning ST Visual Develop, contact the ST nearest sales office. For a complete list of ST offices and distributors, refer to the www.st.com website.

Software updates

Software updates and all the latest documentation can be downloaded from the ST website site at www.st.com.
Contents

1  Read me first ......................................................... 5
   1.1 Host PC system requirements ................................. 5
   1.2 Emulation hardware support ................................. 5
   1.3 About using the Cosmic C toolset ........................... 5
   1.4 About using the Metrowerks C toolset ...................... 6
   1.5 About using the Raisonance C toolset ....................... 6

2  What is new in STVD release 4.3.12? ......................... 6
   2.1 Summary of changes in release 4.3.12 ....................... 6
   2.2 Hardware and targets supported by this release .......... 6
      2.2.1 STice advanced emulation system ..................... 7
      2.2.2 STM8-ICD-SWIM .................................. 8
      2.2.3 ST7-EMU3 emulators .................................. 9
      2.2.4 ST7-DVP3 emulators .................................. 9
      2.2.5 ST7-ICD-ICC ........................................ 10
      2.2.6 ST7-EMU2 (HDS2) emulators ........................... 10
      2.2.7 ST7-DVP/DVP2 emulators (first and second generation) 11
      2.2.8 Simulators .......................................... 11

3  Known problems/limitations ................................. 13
   3.1 Known problems/limitations for STVD installer ............ 13
   3.2 Known problems/limitations for STVD interface .......... 13
      3.2.1 Cosmic C toolset .................................... 13
      3.2.2 Metrowerks C toolset ................................ 13
   3.3 Known problems/limitations for debug interface ........... 14
   3.4 Known problems/limitations for STice targets ............ 14
      3.4.1 Trace ............................................... 14
      3.4.2 NEM breakpoints ..................................... 14
      3.4.3 Profiler ............................................. 15
      3.4.4 USB ................................................ 15
   3.5 Known problems for STM8-ICD-SWIM targets ............... 16
   3.6 Known problems/limitations for ST7-EMU3 targets ......... 16
      3.6.1 ST7MDT10-EMU3 .................................... 16
### 3.7 Known problems/limitations for ST7-DVP3 targets

3.7.1 ST7MDT10-DVP3

### 3.8 Known problems/limitations for ST7-ICD targets

### 3.9 Known problems/limitations for ST7-EMU2 (HDS2) targets

3.9.1 ST7263x-EMU2 emulator

3.9.2 ST7MDTU5-EMU2B emulator

### 3.10 Known problems/limitations for ST7-DVP/DVP2 targets

### 3.11 Known problems/limitations for simulators

### 4 Information on major previous releases

4.1 Summary of changes in release 4.3.11

4.2 Summary of changes in release 4.3.10

4.3 Summary of changes in release 4.3.9

4.4 Summary of changes in release 4.3.8

4.5 Summary of changes in release 4.3.7

4.6 Summary of changes in release 4.3.6

4.7 Summary of changes in release 4.3.5

4.8 Summary of changes in release 4.3.4

4.9 Summary of changes in release 4.3.3

4.10 Summary of changes in release 4.3.2

4.11 Summary of changes in release 4.3.1

4.12 Summary of changes in release 4.3.0

4.13 Summary of changes in release 4.2.1 patch2

4.14 Summary of changes in release 4.2.1 patch1

4.15 Summary of changes in release 4.2.1

4.16 Summary of changes in release 4.2.0

4.17 Summary of changes in release 4.1.6

4.18 Summary of changes in release 4.1.5

4.19 Summary of changes in release 4.1.4

4.20 Summary of changes in release 4.1.3

4.21 Summary of changes in release 4.1.2

4.22 Summary of changes in release 4.1.1

4.23 Summary of changes in release 4.1.0

4.24 Summary of changes in release 4.0.1

20
4.25 Summary of changes in release 4.0 ........................................... 29
4.26 Summary of changes in release 3.5.0 ....................................... 30
4.27 Summary of changes in release 3.4.0 ....................................... 31
4.28 Summary of changes in release 3.3.4 (April 2007) ..................... 32
4.29 Summary of changes in release 3.3.3 (December 2006) .............. 33
4.30 Summary of changes in release 3.3.2 ...................................... 34
4.31 Release 3.3.0/3.3.1 (January/February 2006) ......................... 35
4.32 Release 3.2.1 (October 2005) ............................................... 35
4.33 Release 3.2.0 (December 2004) ............................................ 36
4.34 Release 3.1.0/3.1.1 (December 2004) ..................................... 37
4.35 Release 3.0.1 (October 2004) ............................................... 37
4.36 Release 3.0 (April 2004) ..................................................... 37

5 Revision history ................................................................. 38
1 Read me first

This section provides important information about STVD release 4.3.12.

1.1 Host PC system requirements

PC and compatibles running with:

- Windows® 7 32-bit operating system (for all targets)
- Windows® 7, 8 and 10 64-bit operating systems (for simulator, STice, RLink and ST-LINK targets only)

Note:1 Administrator privileges are required to install STVD and to connect emulators to the USB port for the first time. Power user or administrator privileges are required to run STVD.

Note:2 When using Windows 7, 8 and 10 operating systems, STVD requires administrator privileges to run.

Note:3 Raisonance RLink USB driver is not installed during the STVD installation. RLink users must install RLink USB driver by selecting Start>Programs>ST Toolset>Setup>Install RLink driver. On Windows 8 operating system, users must install the RLink USB driver with the installation files that are available under <Program Files> \STMicroelectronics\st_toolset\stvd\icd\rlink_driver directory.

Note:4 On Windows 8 operating system, the STice USB driver is not installed during the STVD installation. STice users must install STice USB driver using the installation files available under <Program Files>\STMicroelectronics\st_toolset\stvd\STice\signedDriver directory.

1.2 Emulation hardware support

This version includes the ST7 simulator (no emulation hardware is required) and supports certain ST7-EMU2 (HDS2) emulators with active probes, all generations of ST7-DVPx emulators, ST7-EMU3 Series emulators and in-circuit debugging with the ST7-EMU3 with ICC Add-on, the ST7-DVP3 Series emulators, the Raisonance RLink, ST7-STICK, ST-LINK, and the STice advanced emulation system.

Section 2.2: Hardware and targets supported by this release provides a list of supported ST7 and STM8 devices for each STVD debugging target (emulators, ICD and Simulator)

1.3 About using the Cosmic C toolset

STVD release 4.3.12 was validated using the Cosmic C toolset versions 4.4.2 for STM8. To use the Cosmic C toolset with STVD, the cvdwarf.exe Cosmic converter is needed to generate the *.elf debug information files required by STVD. The cvdwarf.exe Cosmic converter is included in the Cosmic C toolset versions 4.2a and later. User can download this version or a later one from the www.cosmic-software.com web page.
1.4 About using the Metrowerks C toolset

STVD is no longer validated with Metrowerks C toolset.

Note: Industry standard ELF/Dwarf format is the default output format for Metrowerks C toolset. When building, the `-f2` option for the C compiler and the `lib.e20` library are chosen by default.

For legacy compatibility reasons, the Metrowerks C toolset and STVD continue to support the proprietary Hiware format. However, when building their applications, Hiware format users must use a script link file present in the Project Settings interface.

For any reference to “Metrowerks” and “Hiware” in STVD software, examples and documentation refer to the Metrowerks C toolset.

1.5 About using the Raisonance C toolset

STVD release 4.3.12 was validated using version 2.56 of the Raisonance C toolset. To use the Raisonance C toolset with STVD, the `omf2elf.exe` Raisonance converter is needed to generate the `.elf` debug information files required by STVD. The `omf2elf.exe` Raisonance converter is included in the Raisonance C toolset.

2 What is new in STVD release 4.3.12?

2.1 Summary of changes in release 4.3.12

New feature

- Added support for STM8L001J3 et STM8L050J3 microcontrollers on Simulator and Swim debug instruments.

Corrections:

- Allow more than 10 build configurations in a single project
- ‘find in files’ now searches in all selected directories even immediately after having added another ‘additional folder’.
- Allow modification of option bytes of STM8L15xx6, STM8L15xx8, STM8L162(R/M)8 and STM8L052R8 microcontrollers with Swim debug instruments.

2.2 Hardware and targets supported by this release

The ‘F’ notation in MCU names denoting ‘Flash’ variants is only indicated for ICD. Debug instruments support emulation/simulation of Flash variants of the listed MCUs, unless otherwise indicated.
2.2.1 STice advanced emulation system

List of supported devices for emulation with STice:

STM8AF5286, STM8A(F/H)5168, STM8A(F/H)5169, STM8A(F/H)5178, STM8A(F/H)5179,
STM8A(F/H)5188, STM8A(F/H)5189, STM8A(F/H)518A, STM8A(F/H)5198, STM8A(F/H)5199,
STM8A(F/H)519A, STM8A(F/H)51A8, STM8A(F/H)51A9, STM8A(F/H)51AA
STM8AF5268, STM8AF5269, STM8AF5286, STM8AF5288, STM8AF5289, STM8AF528A,
STM8AF52A8, STM8AF52A9, STM8AF52AA
STM8A(F/H)6126, STM8A(F/H)6146, STM8A(F/H)6148, STM8A(F/H)6166, STM8A(F/H)6168,
STM8A(F/H)6169, STM8A(F/H)6176, STM8A(F/H)6178, STM8A(F/H)6179, STM8A(F/H)6186,
STM8A(F/H)6188, STM8A(F/H)6189, STM8A(F/H)618A, STM8A(F/H)6189, STM8A(F/H)6199,
STM8A(F/H)61A9, STM8A(F/H)61AA
STM8AF6126, STM8AF6128, STM8AF612A, STM8AF618A, STM8AF6188, STM8AF6189,
STM8AF6198, STM8AF6199, STM8AF61A8, STM8AF61A9, STM8AF61AA
STM8AF6269, STM8AF6286, STM8AF6288, STM8AF6289, STM8AF628A, STM8AF628B, STM8AF6289,
STM8AF62AA
STM8AF6226TxSSS, STM8AF6246, STM8AF6248, STM8AF6266, STM8AF6268
STM8L051F3, STM8L052C6, STM8L052R8
STM8L101F1, STM8L101F2(P/U), STM8L101F3(P/U), STM8L101G2U, STM8L101G3U,
STM8L101K3U
STM8L151C(2/3), STM8L151C(4/6), STM8L151C8, STM8L151F(2/3), STM8L151F(2/3),
STM8L151G(2/3), STM8L151G(4/6), STM8L151K(2/3), STM8L151K(4/6), STM8L151M8, STM8L151R8,
STM8L152C(4/6), STM8L152C8, STM8L152K(4/6), STM8L152M8, STM8L152R8, STM8L152R8,
STM8L162M8, STM8L162R8
STM8S103F2(P/U), STM8S103F3(P/U), STM8S103K3U
STM8S105C4, STM8S105C6, STM8S105K4, STM8S105K6, STM8S105S4, STM8S105S6
STM8S207CB, STM8S207MB, STM8S207RB, STM8S207SB, STM8S207C6, STM8S207K6,
STM8S207K8, STM8S207R6, STM8S207S6, STM8S207C8, STM8S207M8, STM8S207R8,
STM8S207S8
STM8S208C6, STM8S208R6, STM8S208S6, STM8S208C8, STM8S208R8, STM8S208S8,
STM8S208CB, STM8S208MB, STM8S208MB, STM8S208RB, STM8S208SB
STM8S903K3, STM8S903F3
STM8S003F3/K3, STM8S005C6/K6, STM8S007C8
## STM8-ICD-SWIM

List of supported devices for in-circuit debugging from STVD with ST-Link, RLink, or STice:

<table>
<thead>
<tr>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>STM8AF526, STM8A(F/H)5168, STM8A(F/H)5169, STM8A(F/H)5178, STM8A(F/H)5179, STM8A(F/H)5188, STM8A(F/H)5189, STM8A(F/H)5198, STM8A(F/H)5199, STM8A(F/H)519A, STM8A(F/H)51A9, STM8A(F/H)51AA</td>
</tr>
<tr>
<td>STM8AF5268, STM8AF5269, STM8AF5286, STM8AF5288, STM8AF5289, STM8AF528A, STM8AF52A8, STM8AF52A9, STM8AF52AA</td>
</tr>
<tr>
<td>STM8A(F/H)6126, STM8A(F/H)6146, STM8A(F/H)6148, STM8A(F/H)6166, STM8A(F/H)6168, STM8A(F/H)6169, STM8A(F/H)6176, STM8A(F/H)6178, STM8A(F/H)6179, STM8A(F/H)6186, STM8A(F/H)6188, STM8A(F/H)6189, STM8A(F/H)618A, STM8A(F/H)6198, STM8A(F/H)6199, STM8A(F/H)619A, STM8A(F/H)61A8, STM8A(F/H)61A9, STM8A(F/H)61AA</td>
</tr>
<tr>
<td>STMAF6269, STMAF6286, STMAF6288, STMAF6289, STMAF628A, STMAF62A8, STMAF62A9, STMAF62AA</td>
</tr>
<tr>
<td>STM8AF6223, STMAF6223A, STMAF6223PxA, STM8AF6226</td>
</tr>
<tr>
<td>STM8AL3146, STM8AL3148, STM8AL3166, STM8AL3168, STM8AL3188, STM8AL3189, STM8AL318A, STM8AL3L46, STM8AL3L48, STM8AL3L66, STM8AL3L68, STM8AL3L88, STM8AL3L89, STM8AL3L8A, STM8AL3L8B, STM8AL3L8E8, STM8AL3L8E9, STM8AL3LE8A, STM8AL3LE8B, STM8AL3LE89, STM8AL3LE8E8, STM8AL3LE8E9, STM8AL3LE8SSS and STM8AL3LE8SSS</td>
</tr>
<tr>
<td>STM8AF6213, STMAF6226TXSSS, STM8AF6246, STM8AF6248, STM8AF6266, STM8AF6268</td>
</tr>
<tr>
<td>STM8L050J3, STM8L051F3, STM8L052C6, STM8L052R8</td>
</tr>
<tr>
<td>STM8L001J3, STM8L101F1, STM8L101F2(P/U), STM8L101F3(P/U), STM8L101G2U, STM8L101G3U, STM8L101K3(U/T)</td>
</tr>
<tr>
<td>STM8L151C(2/3), STM8L151C(4/6), STM8L151C8, STM8L151F(2/3), STM8L151G(2/3), STM8L151G(4/6), STM8L151K(2/3), STM8L151K(4/6), STM8L151M8, STM8L151M8, STM8L151R8, STM8L152C(4/6), STM8L152C8, STM8L152K(4/6), STM8L152K8, STM8L152M8, STM8L152R6, STM8L152R8</td>
</tr>
<tr>
<td>STM8L162M8, STM8L162R8</td>
</tr>
<tr>
<td>STM8S001J3, STM8S003F3/K3, STM8S005C6/K6, STM8S007C8</td>
</tr>
<tr>
<td>STM8S013F2(P/U), STM8S103F3(P/U), STM8S103K3U</td>
</tr>
<tr>
<td>STM8S105C4, STM8S105C6, STM8S105K4, STM8S105K6, STM8S105S4, STM8S105S6</td>
</tr>
<tr>
<td>STM8S207C, STM8S207MB, STM8S207RB, STM8S207SB, STM8S207K6, STM8S207K8, STM8S207R6, STM8S207R8, STM8S207S8</td>
</tr>
<tr>
<td>STM8S208C6, STM8S208R6, STM8S208S6, STM8S208C8, STM8S208R8, STM8S208S8, STM8S208CB, STM8S208MB, STM8S208MB, STM8S208RB, STM8S208SB</td>
</tr>
<tr>
<td>STM8S903K3, STM8S903F3</td>
</tr>
<tr>
<td>STM8TL53C4, STM8TL53G4, STM8TL53F4, STM8TL52G4, STM8TL52F4</td>
</tr>
</tbody>
</table>
2.2.3 ST7-EMU3 emulators

List of supported devices by emulator:

- ST72260G1, ST72262G(1/2), ST72264G(1/2), ST7DALI, ST7LCD1, ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7LTE(02/05/09/10/15/19/20/25/29/30/35/39), ST7LITES(2/5), ST7LITEUS(2/5), ST7FLITEU0(2/5/9), ST7L05/09/15/19/34/35/38/39)
- ST72321BJ(6/7/9), ST72321J(7/9), ST72321BK6, ST72324BJ(2/4/6), ST72324BK(2/4/6), ST72324BLJ(2/4/6), ST72324BLK(2/4/6),
- ST72324J(2/4/6), ST72324K(2/4/6), ST72324LJ(2/4/6), ST72324LK(4/6), ST72325C(4/6), ST72325J(4/6/7/9), ST72325K(4/6), ST72324J(1/2), ST72324K(1/2)
- ST72321AR(6/7/9), ST72321BAR(6/7/9), ST72321BR(6/7/9), ST72321R(6/7/9), ST72325AR(6/7/9), ST72325R(6/7/9),
- ST72521AR(6/9), ST72521BAR(6/9), ST72521BR(6/9), ST72521BM9, ST72521M9, ST72521R(6/9),
- ST72340K(2/4/6), ST72340S(2/4), ST72344K(2/4), ST72344JS2/4), ST72345C4
- DVD3, L6315_10_RAM, L6315_10_ROM
- ST7XGAM(J4T1/K4M1), ST7XGAM(J6T1/K6M1), ST7HUBAR4T1, ST7HUBAR6T1
- ST7MDTU3-EMU3 ST7260E(1/2), ST7260K(1/2), ST7263BE(1/2/4/6), ST7263BH(2/6), ST7263BK(1/2/4/6)
- ST7FLCD-EMU3 ST7LCD1

2.2.4 ST7-DVP3 emulators

List of supported devices by emulator:

- ST72260G1, ST72262G(G1/G2), ST72264G(G1/G2), ST7DALI, ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7LTE(02/05/09/10/15/19/20/25/29/30/35/39), ST7LITES(2/5), ST7LITEUS(2/5), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7LTE(02/05/09/10/15/19/20/25/29/30/35/39), ST7LITES(2/5), ST7LITEUS(2/5), ST7L05/09/15/19/34/35/38/39)
- ST72321AR(6/7/9), ST72321BAR(6/7/9), ST72321BJ(6/7/9), ST72321BK6, ST72321BR(6/7/9), ST72321J(7/9), ST72321M(6/9), ST72321R(6/7/9),
- ST72324BJ(2/4/6), ST72324BK(2/4/6), ST72324BLJ(2/4/6), ST72324BLK(2/4/6), ST72324J(2/4/6), ST72324K(2/4/6), ST72324LJ(2/4/6), ST72324LK(2/4/6), ST72324J(2/4/6), ST72324K(2/4/6), ST72324LJ(2/4/6), ST72324LK(2/4/6),
- DVD3, L6315_10_RAM, L6315_10_ROM
- ST7XGAM(J4T1/K4M1), ST7XGAM(J6T1/K6M1), ST7HUBAR4T1, ST7HUBAR6T1
- ST7MDTU3-EMU3 ST7260E(1/2), ST7260K(1/2), ST7263BE(1/2/4/6), ST7263BH(2/6), ST7263BK(1/2/4/6)
- ST7FLCD-EMU3 ST7LCD1

DocID12917 Rev 35 9/42
2.2.5 ST7-ICD-ICC

Applications can be in-circuit debugged from STVD using any of the following development tools and with the microcontrollers listed below:

- **ST7MDT10-DVP3, ST7MDT20-DVP3, ST7MDT25-DVP3 series emulators**: they are all accessed from STVD as *ICD* (*ST Micro Connect or DVP3*).
- **ST7-EMU3 series emulators** – ST Micro Connect with ICC add-on. They are all accessed from STVD as *ICD* (*ST Micro Connect or DVP3*).
- **RLink** from Raisonance (accessed from STVD as *ICD RLink*).
- **ST7-STICK** (accessed from STVD as *ICD Stick*).

List of supported devices for in-circuit debugging:

- ST72260G1, ST72262(G1/G2), ST72264(G1/G2), ST7267
- ST7FDALI, ST7FLCD1
- ST7FLIT10BF(0/1), ST7FLIT15BF(0/1), ST7FLIT19BF(0/1), ST7FLIT10BY(0/1), ST7FLIT15BY(0/1), ST7FLIT19BY(0/1)
- ST7FLITE0(2/5/9), ST7FLITE1(0/5/9), ST7FLITE2(0/5/9), ST7FLITE3(0/5/9), ST7FLITES(2/5), ST7FLITEUS(2/5), ST7FLITEUSICD, ST7FLITEUSICD
- ST7FL1(5/9), ST7FL3(4/5/9/9)
- ST7WIND11, ST7WIND21
- ST7FMC1K(2/4/6), ST7FMC2(M9/N6/R6/R7/R9/S4/S6/S7/S9), ST7FMC2R9, ST7FMC2S9
- ST7FLITE49M
- ST7FOXK2, ST7FOXK2, ST7FLITE49K2T6, ST7FLITE49K2B6

2.2.6 ST7-EMU2 (HDS2) emulators

List of supported devices by emulator:

- ST7MDT00-EMU2B ST7LITE0(5/9)
- ST7MDT1-EMU2B ST72104G(1/2), ST72215G2, ST72216G1, ST72254G(1/2)
- ST7MDT2-EMU2A ST72124J2, ST72311R(6/7/9)
- ST7MDT5-EMU2B ST72141
- ST7MDT6-EMU2B ST72171K2(B/M)6
- ST7MDT7-EMU2B ST72C411R1
- ST7MTS1-EMU2B ST7SCR1(E/R)
- ST7MDTU2-EMU2B ST72611F1, ST72P611F4, ST72621J(2/4), ST72621K4, ST72621L4, ST72622(K/L)2, ST72623F2
- ST7MTU3-EMU2B ST72638K(1/2), ST72638K4
- ST7MTU5-EMU2B ST72651, ST72652
- ST7263-EMU2B ST72631, ST72632, ST72633
- ST72774-EMU2B ST72734J6, ST72754J(6/9), ST72774J(6/7/9)

(continued)
(ST7-EMU2 (HDS2) emulators continued)

ST7MDT1-EMU2  ST72101G(1/2), ST72212G2, ST72213G1, ST72251G(1/2)
ST7255B-EMU2  ST7255B
ST7285-EMU2    ST7285
ST7291-EMU2    ST7291L(2/3/4/5/5A/6)
ST72589B-EMU2  ST72389(B/C), ST72589(B/C)

2.2.7  ST7-DVP/DVP2 emulators (first and second generation)

ST7MDT1-DVP    ST72101G(1/2), ST72212G2, ST72213G1, ST72251G(1/2)
ST7MDT1-DVP2   ST72101G(1/2), ST72104G(1/2), ST72212G2, ST72213G1, ST72251G(1/2),
                ST72216G1, ST72251G(1/2), ST72254G(1/2)
ST7MDT2-DVP2   ST72124J2, ST72311R(6/7/9), ST72314J(2/4), ST72314N(2/4), ST72334J(2/4),
                ST72334N(2/4), ST72351R(6/7/9), ST72512R4, ST72532R4
ST7MDP-DVP2    ST7MDP

2.2.8  Simulators

ST7 baseline
ST72101G(1/2), ST72104G(1/2), ST72121J(2/4), ST72124J2, ST72212G2, ST72213G1, ST72215G2,
ST72216G1, ST72251G(1/2), ST72254G(1/2), ST72311J(2/4), ST72311N(2/4), ST72314J(2/4),

ST7 lite
ST7260G1, ST72262G(1/2), ST72264G(1/2), ST7DALI, ST7LIT10BF(0/1),
ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1),
ST7LIT19BY(0/1), ST7LITE02/05/09/10/15/19/20/25/29/30/35/39,
ST7LITES2/5, ST7L05/09/35/39, ST7FLITEU0(2/5/9), ST7FLITE49M,
ST7FOXK1, ST7FOXK2, ST7FOXK1, ST7FOXK1, ST7FLUS5, ST7FLU05,
ST7FLU09, ST7FLJ49K2T6, ST7FLJ49K2B6

ST7 mid-range
ST7232AJ(1/2), ST7232AK(1/2), ST7232AR(6/9), ST72321AR(6/7/9),
ST72321BJ(6/7/9), ST72321BK6, ST72321BR(6/7/9), ST72321J(7/9),
ST72321M(6/9), ST72321BM(6/9), ST72321R(6/7/9), ST72324BJ(2/4/6),
ST72324BK(2/4/6), ST72324BLK(2/4), ST72324BLK(2/4), ST72324J(2/4/6),
ST72324K(2/4/6), ST72324LS(2/4), ST72324LS(2/4), ST72325AR(6/7/9),
ST72325C(6/7/9), ST72325S(6/7/9), ST72325J(4/6/7/9), ST72325K(4/6/7/9),
ST72325R(7/9), ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9),
ST72361R(4/6/7/9), ST72340K(2/4), ST72340S(2/4), ST72344K(2/4),
ST72344S(2/4), ST72345C4

ST7 CAN     ST72511R(6/7/9), ST72521AR(6/9), ST72521M9, ST72521R(6/9)
ST7 LCD     ST72389B, ST72589B
ST7 MC      ST72141
ST7 OP      ST72171
(continued)
(Simulators continued)

**ST7 USB**
- ST7260E(1/2), ST7260K(1/2), ST72631, ST72632, ST72633, ST7263B0D6, ST7263BH(2/6), ST7263BE(1/2/4/6), ST7263BK(1/2/2U1/4/6)
- ST88A5286, ST88A(F/H)5168, ST88A(F/H)5169, ST88A(F/H)5178, ST88A(F/H)5179, ST88A(F/H)5188, ST88A(F/H)5189, ST88A(F/H)518A, ST88A(F/H)5198, ST88A(F/H)5199, ST88A(F/H)519A, ST88A(F/H)51A8, ST88A(F/H)51A9, ST88A(F/H)51AA
- ST88A5268, ST88A5269, ST88A5286, ST88A5288, ST88A5289, ST88A528A, ST88A528B, ST88A5298, ST88A5299, ST88A52AA
- ST88A(F/H)6126, ST88A(F/H)6146, ST88A(F/H)6148, ST88A(F/H)6166, ST88A(F/H)6168, ST88A(F/H)6169, ST88A(F/H)6176, ST88A(F/H)6178, ST88A(F/H)6179, ST88A(F/H)6186, ST88A(F/H)6188, ST88A(F/H)6189, ST88A(F/H)618A, ST88A(F/H)6198, ST88A(F/H)6199, ST88A(F/H)619A, ST88A(F/H)61A8, ST88A(F/H)61A9, ST88A(F/H)61AA
- ST88A6223, ST88A6223A, ST88A6223PxA and ST88A6226
- ST88A6226TxSSS, ST88A6246, ST88A6248, ST88A6266, ST88A6268
- ST88L050U3, ST88L051F3, ST88L052C6, ST88L052R8
- ST88L01F1, ST88L101F2(P/U), ST88L101F3(P/U), ST88L101G2U, ST88L101G3U, ST88L101K3(U/T)
- ST88S152C4(4/6), ST88S152C8, ST88S152K8, ST88S152K4(4/6), ST88S152M8, ST88S152R8, ST88S152R6
- ST88S162M8, ST88S162R8
- ST88S001F3, ST88S003F3/K3, ST88S005C6/K6, ST88S007C8
- ST88S207M8, ST88S207RB, ST88S207CB, ST88S207R8, ST88S207C6, ST88S207C8, ST88S207S8, ST88S207S6, ST88S207R6, ST88S207K6, ST88S207K8, ST88S207M8, ST88S207S8, ST88S208R6, ST88S208C8, ST88S208S6, ST88S208S8, ST88S208M8, ST88S208CB, ST88S208SB, ST88S208MB, ST88S208RB
- ST88S903K3, ST88S903F3
- ST88TL53C4, ST88TL53G4, ST88TL53F4, ST88TL52G4, ST88TL52F4
3 Known problems/limitations

3.1 Known problems/limitations for STVD installer

- To get the required driver installed, STVD must be installed prior to connect a debug instrument to the host PC USB port.
- On some systems, the DAO-3.5 objects, required by Swim and STice targets, are not correctly installed. As a result, this error is displayed: '[40201]: can’t access configuration database', when starting to debug on those targets.
  A first workaround consists in running with administrator privileges the package 
  `<ST_Toolset>/stvd/dao/ST Toolset.msi` (where `<ST_Toolset>` is typically 'C:/Program Files/STMicroelectronics/st_toolset' on 32 bits systems and 'C:/Program Files (x86)/STMicroelectronics/st_toolset' on 64 bits systems).
  If the issue persists afterwards, run both following commands from a command prompt in administrator mode (example for 64-bit systems):
  - `Regsvr32 /u ‘C:\Program Files (x86)\Common Files\Microsoft Shared\DAO\DAO350.DLL’`
  - `Regsvr32 ‘C:\Program Files (x86)\Common Files\Microsoft Shared\DAO\DAO350.DLL’`

3.2 Known problems/limitations for STVD interface

The include files provided upon the installation of STVD, are not the same as those required when using the ST7 library or STM8 library. Users should refer to the appropriate ST7 or STM8 library documentation for information about the correct include files to use.

3.2.1 Cosmic C toolset

In the Cosmic Linker for STM8 microcontrollers, the .const segment must be located in the first 64-Kbyte segment. This is mandatory because the Cosmic toolset cannot link an interrupt handler that is not located in segment 1.

3.2.2 Metrowerks C toolset

- The automatic generation of the linker PRM file can only be used when generating an executable in ELF/DWARF 2.0 format. For Hiware format, users must use a written PRM file.
- Using the -StatF= option with Hiware format may cause a failure during linking. The executable is not produced.
- When using the recommended ELF format and STVD include files, a link error L1818 may be generated due to paginated registers. User can add the option `-vmsgsi1818` as a user-defined option. This option converts the error to a warning message only.

Note: STVD is no longer validated with Metrowerks C toolset.
3.3 Known problems/limitations for debug interface

- When the program is stopped on a breakpoint set on a function name, the displayed argument values may be false.
- When *.hex or *.s19 files are loaded outside of any workspace, an error message is displayed, but it is meaningless.
- Double type variables are referred as ‘float type’ variables.
- The `const` variable qualifier is not displayed.
- Only one instance of STVD can run on the PC at any given time.
- Reduced user access rights to the database registry or to the STVD install directory can impede the normal use of STVD. A warning message occurs if a read/write access problem occurs.
- The size of project.wed and project.wdb files might sometimes increase in an unexpected way during the lifetime of the project. In that case it is recommended:
  - to delete *.wed and *.wdb files of all the projects contained into the STVD workspace, including the “default” ones stored in <st_toolset>/stvd. These files do not contain critical project data but user configuration data such as the breakpoints, list of opened files, list and position of windows, and will be created again during the next STVD debug session
  - to avoid using customized toolbars if possible (a cleanup might be done: tools-options-toolbars-reset all)

3.4 Known problems/limitations for STice targets

3.4.1 Trace

Trace activation is only possible through the advanced debug machine (ADM) interface on STice emulator, not through the simplified one.

3.4.2 NEM breakpoints

NEM breakpoints on data access are limited to the memory area range [0-0x7FFF], NEM breakpoints on opcode fetch are limited to addresses higher than 0x7FFF.
3.4.3 Profiler

- Coverage and profiling functionality is limited to core running at up to 24 MHz.

- **Code occurrence and time profiling** limitations:
  - Whatever the *time profiling* mode, the profiler does not profile the first or the first two instructions after a breakpoint.
  - It also does not profile correctly the last or the last two instructions before a breakpoint.
  - The number of occurrences of an interrupted instruction may be false. In particular:
    - The occurrence number of the WFE instruction is doubled.
    - The occurrence number of an IRET instruction may be null if it is always executed in a shortened way. A shortened IRET is an IRET which is executed in one cycle only because of a pending interrupt being serviced immediately after.
    - In some rare cases, the occurrence number of an interrupted instruction is doubled.
  - Contrarily to what is said in the online help, the *Subroutine* mode (interrupt time excluded) is not available in this release. Only the *Subroutine and Interrupt* mode (interrupt time included) is available.

- Time profiling limitations in *Instruction* mode:
  - Context saving time is added to the interrupted instruction time.

- Time profiling limitations in the *Subroutine and Interrupt* mode:
  - The time for recursive functions is not correct.
  - The longjmp C library routine should not be used otherwise the results will be erroneous.
  - The results may be incorrect with the Raisonance compiler if it calls a library routine which uses the stack in a nonstandard way.
  - For code written in assembly language, the subroutine modes work only if routines use the stack in a standard way. To be certain there is no problem, make sure that each routine is called by a call instruction and that it returns to its caller by a return instruction.
  - In the case of pending interrupts resulting in the occurrence of several immediately consecutive interrupts, the time of the interrupted instruction doesn't include all the time spent in the interrupts.
  - Similarly an IRET followed immediately by a pending interrupt is seen as interrupted and its time includes the time of the following interrupt.

3.4.4 USB

USB communications may sometimes be lost in *full speed* mode (12 Mbit/s), depending on the frame length. It is recommended to use the STIce on a PC supporting USB high speed communications (480 Mbit/s).
3.5 Known problems for STM8-ICD-SWIM targets

- The debugger needs to unlock the Flash and data EEPROM memories each time the user application stops; in order to avoid conflict with the application, avoid stepping or stopping in the portion of code managing the MASS key sequences (if any).
- When starting a debug session in hotplug mode, a watchdog timeout reset may occur if the application previously activated the watchdog.

3.6 Known problems/limitations for ST7-EMU3 targets

- When the emulated MCU is executing a Halt or Wait for Interrupt instruction and application execution is stopped using **Debug>Stop Program** or an external trigger, upon continuation, certain counters like timers and watchdog will have increased or decreased by several pulses.
- The Time Stamp in the Trace window includes Discarded events, including those used by the emulator at a break in execution (breakpoint) and when stepping through the code. The time stamps that result from stepping through a section of code will differ from those that result if the same code is run normally. The time stamps are not recalculated when filtering is used to remove events from the Trace display.
- When the microcontroller is in a Halt state, it is not possible to reset it using the LVD RESET command from the STVD Hardware Simulation window.
- Writing to Flash program and EEPROM program non-volatile memory via the associated control registers are not emulated. The default memory mapping configuration for these areas is read only, however they can be changed to R/W (RAM) if necessary.
- Target MCUs, the Reset vector is not displayed in Trace Window.
- When using an I2C or DDC peripheral, use a pull-up resistor of 1.5 kOhms or less.
- The Performance Analysis has the following limitations:
  - Performance Analysis does not work properly if the portion of code analyzed has entry/exit points not monitored by the Performance Analysis tool.
  - Timestamp discontinuity can occur when the required number of passes on a code fragment is too large.

Note: The command **Debug Instrument>Debugging discrepancies** displays the differences between the emulation system and the target MCU.

3.6.1 ST7MDT10-EMU3

- The following limitations are not included in the **Debugging discrepancies** window:
  - All ST7FLITE devices (except the ST7226x): When using PA4 and PA6 as input for VIL = 0.4V there is an IIL current of 200 µA.
  - All ST7FLITE1B devices: The analog comparator is not emulated. As a result these registers have been mapped as non-existent registers (NER), and a break in execution will occur if they are accessed by the application. If the users
application uses these registers, they can be mapped to read/write in the Memory Mapping window so that a break will not occur when they are accessed.

- When emulating the ST72F26xx family with the ST7MDT10-EMU3 emulator, the memory area from 0xd760 to 0xDEDF is typically defined as non-existent memory (NEM). Do not change this, as the emulator cannot interpret instructions in this zone.
- AWU RC calibration is not supported because this RC is emulated by a fixed frequency from an oscillator.
- RC oscillator and the input capture are not connected for the auto-reload timer.

### 3.7 Known problems/limitations for ST7-DVP3 targets

- When the emulated MCU is executing a Halt or Wait for Interrupt instruction and application execution is stopped using Debug>Stop Program or an external trigger, upon continuation, certain counters like timers and watchdog will have increased or decreased by several pulses.
- Upon wake up from a Halt or Wait for interrupt state, if STVD stops execution on a breakpoint that has been set on the first instruction of an interrupt routine, the position of the program counter (PC) in relation to the last instruction executed is incorrect (PC stops one address prior to the address of the break point). To avoid this, users should not set breakpoints on the first instruction of the wake up interrupt routine.
- The minimum frequency for DVP3 emulators is 2 MHz, instead of 500 KHz.
- When using an I²C or DDC peripheral, use a pull-up resistor of 1.5 kOhms or less.
- In the hardware event window if the event type is changed, the address of the hardware event is incremented automatically.

#### 3.7.1 ST7MDT10-DVP3

- The following limitations are not included in the Debugging discrepancies window:
  - All ST7FLITE devices (except the ST7226x): When using PA4 and PA6 as input for VIL = 0.4 V there is an IIL current of 200 µA.
  - All ST7FLITE1B devices: The analog comparator is not emulated. As a result these registers have been mapped as non-existent registers (NER), and a break in execution will occur if they are accessed by the application. If the application uses these registers, they can be mapped to read/write in the Memory Mapping window so that a break will not occur when they are accessed.
- AWU RC calibration is not supported because this RC is emulated by a fixed frequency from an oscillator.
- RC oscillator and the input capture are not connected for the auto-reload timer.

**Note:** The command Debug Instrument>Debugging discrepancies displays the emulation limitations that are specific to the target MCU.
3.8 Known problems/limitations for ST7-ICD targets

- The following apply when in-circuit debugging of applications on XFlash devices without a debug module (ST72FLITE0/S and ST72F26x):
  - Flash memory from FF12-FFDF is used for the debug monitor (ST7FLITE0/S).
  - Stop Program is not possible (error and loss of communication with the target).
  - Advanced Breakpoints are not possible (feature cannot be accessed in the GUI).
  - Instruction Breakpoints in the Flash sector 0 are not possible (error message).
  - Stepping in the Flash sector 0 is not possible (results in an error message).
- STVD must be installed prior to connecting a debug instrument to the host PC’s USB port, in order to have the necessary driver.
- Some changes made to the MCU memory mapping in STVD are not taken into account during in-circuit debugging as they are controlled by the device’s option byte.
- The Step Over command does not work properly when timer interrupt frequency is too high. As a workaround, select Debug Instrument>Stepping Mode and change the mode to Don’t Enter Interrupts When Stepping Into.
- The TRAP instruction generated by a software breakpoint can set off a hardware breakpoint when the hardware breakpoint points to an address in the stack. When this happens the application crashes. The program counter’s (PC) real position is not the same as the position reported in the Disassembly window. Before continuing, reset the position of the PC:
  - by entering the desired position for the PC in the Program Counter field of the ST7 Register window, or
  - by highlighting the position in the Disassembly window and clicking on Set PC.
Workaround: Do not set hardware breakpoints in the stack when using software breakpoints, or when the Stepping mode is set to Don’t Enter Interrupts When Stepping Into.

Note: The command Debug Instrument>Debugging discrepancies displays the emulation limitations that are specific to the target MCU.

3.9 Known problems/limitations for ST7-EMU2 (HDS2) targets

- When using an I²C or DDC peripheral, use a pull-up resistor of 1.5 KOhms or less.
- No time indication is recorded and displayed in the trace window.
- Clear Trace command does not work properly.

3.9.1 ST7263x-EMU2 emulator

- Timer A behaves incorrectly.
3.9.2 ST7MDTU5-EMU2B emulator

ST72652 and ST72F652 are supported by this emulator, but with the following limitations due to problems/limitations with some versions of the target MCU:

- Normally ADC, I²C and PWM are not available for these sale types, but they are still present when ST72652 is selected in the MCU Configuration window.
- Options bytes are not user-configurable at present. Refer to the ST7MDTU5-EMU2B (HDS2) Emulator User Manual for details.

3.10 Known problems/limitations for ST7-DVP/DVP2 targets

- A complete host PC crash may occur if the development kit board is powered off during an STVD session. In particular, if Debug mode is changed to Build mode, then power off is executed on the development kit board, and the Debug mode is re-entered again (with the development kit board powered off), a total host system crash will occur.
- The CPU frequency (FCPU) of the emulated device must be set in a range from 500 KHz to 8 MHz even if Slow mode is selected. The link between FCPU and CLOCK is: \( FCPU = \frac{CLOCK}{2} / \text{Slow mode} \) (e.g. If a 5 MHz external clock is used it is possible to select Slow mode factor 8, but not factor 16).

3.11 Known problems/limitations for simulators

Known problems or limitations on all microcontrollers:

- When exporting graphed information from the Plotter window to VCD file, select an item with all its subitems, or all plotted items to ensure that no information is lost. Time information loss may occur when exporting selected subitems within an item.

Known problems or limitations on ST7 microcontrollers:

- The following is the list of peripherals that are supported during simulation:
  - ADC
  - Autoreload Timer (for ST7FLITE)
  - Beep
  - EEPROM
  - I²C
  - I/O Ports
  - Lite Timer (for ST7FLITE)
  - Main Clock Controller
  - PWM Autoreload Timer
  - Real Time Clock
  - SCI
  - SPI
  - Timer
  - Watchdog

- Known peripheral problems/limitations: there is a conflict between ports and peripherals for pin access. No arbitration is done by the Simulator. If a peripheral is used, do not use the pins which are connected to this peripheral as standard input/output pins.

Known problems or limitations on STM8 microcontrollers:

- The STM8 instruction simulator is not accurate in terms of number of cycles. The number of cycles given for an instruction is the minimum number of cycles found in the
programming manual. It does not take into account possible slowdowns in the pipeline execution.

- STM8 peripherals are not supported. However, in addition to instruction set simulation, interrupts are supported through pseudo pins IRQ0 to IRQ29.

4 Information on major previous releases

4.1 Summary of changes in release 4.3.11

New feature

Added support for STM8L152K8 and STM8S001J3 microcontrollers on Simulator and Swim debug instruments.

4.2 Summary of changes in release 4.3.10

Correction

Mapping of STM8L052R8 modified with 64 K Flash for correct display in disassembly window.

4.3 Summary of changes in release 4.3.9

New features

- Added support for STM8AL31E89, STM8AL31E8A, STM8AL3LE89 and STM8AL3LE8A on Simulator and Swim debug instruments.
- Added support for STM8AF6223A on Simulator and Swim debug instruments.

4.4 Summary of changes in release 4.3.8

Correction

Base address of AES peripheral is 0x53D0 on STM8L162M8 and STM8L162R8 (impacts the Peripheral Register window and include files).

4.5 Summary of changes in release 4.3.7

New features

- Added support for STM8AL3188, STM8AL3189, STM8AL318A, STM8AL3L88, STM8AL3L89, STM8AL3L8A,
- STM8AL31E88 and STM8AL3LE88 on Simulator and Swim debug instruments.
- Added support for STM8AF6213 on Simulator and Swim debug instruments.
4.6 Summary of changes in release 4.3.6

New features
Add support for STM8AF5286, on Simulator, STice and Swim debug instruments.

Correction
Added automatic call to \<st_toolset>/stvd/dao/ST Toolset.msi during installation in order to ensure the presence of DAO objects required for STVD databases access.

4.7 Summary of changes in release 4.3.5

New features
- Added support for STM8AF6223, STM8AF6223PxA and STM8AF6226 on simulator and SWIM debug instruments
- Provided signed drivers for Windows 8 for RLink, ST-LINK and STice debug instruments.

Correction
Fixed bug on SWIM debug instrument, related to bad management of data EEPROM unlock sequence when application code stopped during such sequence.

4.8 Summary of changes in release 4.3.4

New features
Added support for STM8AL3146, STM8AL3148, STM8AL3166, STM8AL3168, STM8AL3L46, STM8AL3L48, STM8AL3L66, STM8AL3L68, STM8AL3136xxSSS and STM8AL3138xxSSS on Simulator and SWIM debug instruments.

Correction
Suppressed «Invalid parameter» error sometimes occurring on versions of Microsoft Windows with Multi Bytes Character Set enabled (Korean version for instance).

4.9 Summary of changes in release 4.3.3

Correction
STM8AF6226 device renamed into STM8AF6226TxSSS.
4.10 Summary of changes in release 4.3.2

New features

- Added support for STM8S207K8, STM8TL52G4, microcontroller on Simulator, SWIM and STice emulators.
- Added support for STM8TL52F4 and STM8TL53F4 microcontrollers on Simulator and SWIM emulators.
- Added support for STM8S003F3/K3, STM8S005C6/K6, and STM8S007C8 microcontrollers on STice emulator.

Correction

- RAM size of STM8A(F/H)518A, STM8A(F/H)618A, STM8AFx26x and STM8AFx28x microcontrollers extended to 6 Kbytes [0-17FF], including stack.
- Data EEPROM size of STM8AF518A, STM8AF618A and STM8AFx28x microcontrollers extended to 2 Kbytes.
- RAM size of STM8AF6226 and STM8AF624x microcontrollers extended to 2 Kbytes [0-7FF], stack included.
- STM8S103K3U microcontroller renamed STM8S103K3.
- Fixed issue that caused SWIM communication with RLink to be lost when loading applications under very specific size and alignment conditions.
- Fixed issue in STLinkUSBDriver.dll v4.2.2.0 that for bad access to the ST-Link in some PC configurations.
- No more graphical freeze when too many errors found during file preprocessing phase for symbol browsing.
- No more crash after assembly error.
- No more crash when selecting a build configuration different from the first one.

4.11 Summary of changes in release 4.3.1

New features

Added support for STM8TL53C4 and STM8TL53G4 microcontrollers on Simulator, SWIM and STice emulator.

Corrections

- RAM size of all STM8S20x microcontrollers extended to 6 Kbytes [0-17FF], stack included.
- Fixed regression in STVD-4.3.0: graphical freeze when opening a source file including a header file referred through a relative path containing space character(s).
- Fixed regressions in STVD-4.3.0 in the case of Raisonance projects.
4.12 Summary of changes in release 4.3.0

New features
- Added symbol browsing (go to definition, go to declaration) in edit mode
- Added completion on user’s request (control+space) in edit mode
- Added function call tips
- Added support for STM8S003F3/K3, STM8S005C6/K6, STM8S007C8 microcontrollers on Simulator and SWIM
- Added support for STM8S208M8 microcontroller on Simulator, SWIM and STice emulator

Corrections
- Fixed Project Settings window display issue (truncated) on Japanese, Korean and Chinese versions of Windows XP (regression appeared in STVD-4.2.1)
- Fixed possible crash when starting debug with the STice (regression appeared in STVD-4.2.1)
- Fixed communication issue when using the Programmer tool with RLink (target communication was established only once)
- Fixed STM8L151Gx ADC not fully functional on STice emulator

4.13 Summary of changes in release 4.2.1 patch2

Corrections
Resolved issue that caused “incorrect parameter” message and prevented application build, when building project with STVD-4.2.1 patch1 on PC with time zone defined as GMT-x(x>0). Patch2 replaced patch1, apply directly to either STVD-4.2.1 or STVD-4.2.1 patch1.

4.14 Summary of changes in release 4.2.1 patch1

New features

Corrections
- Fixed issue that caused application crash during ST-Link enumeration on some PCs with STLinkUSBDriver.dll v4.2.1.0
- Modified timings for correct initialization of the SWIM communication with STM8L DISCOVERY boards
- Fixed infinite loop issue that occurred in case of SWIM communication error after SWIM_COMM_RESET command
- Added peripheral description for STM8A(F/H)(5/6)2xx microcontrollers
- Fixed issue that caused SWIM communication with RLink to be lost when loading applications under very specific size and alignment conditions
4.15 Summary of changes in release 4.2.1

New features

- STice, STM8-ICD-SWIM and STM8 simulator support for the STM8L101F1 microcontroller
- Support for Windows 7
- STice driver updated for Windows Vista 64 bits and Windows 7 64 bits

Corrections

- Fixed bug in ‘obsend’ command with ST Assembler Linker
- Fixed bug in Raisonance omf2hex post-build command for applications which exceed 64 Kbytes in size
- Fixed bug for STM8L162M8: bad mapping on STice emulator for AES register
- Updated graphical library

4.16 Summary of changes in release 4.2.0

New features

- Added a simplified graphical interface for advanced debug machine (ADM) on STice emulator. Trace activation is only possible through the ADM advanced interface, not through the simplified one.
- Rework of project settings inheritance between folders and files. In project tree, project files with settings different from their father folder are marked with a special icon.
- STice, STM8-ICD-SWIM and STM8 simulator support the following additional microcontrollers:
  - STM8L151C8, STM8L151M8, STM8L151R8, STM8L151R6, STM8L152C8, STM8L152M8, STM8L152R8, STM8L152R6, STM8L162M8, STM8L162R8.
  - STM8A(F/H)5268, STM8A(F/H)5269, STM8A(F/H)5288, STM8A(F/H)5289, STM8A(F/H)52A8, STM8A(F/H)52A9, STM8A(F/H)52AA, STMA(F/H)6269, STMA(F/H)6286, STMA(F/H)6288, STMA(F/H)6289, STMA(F/H)62A8, STMA(F/H)62A9, STMA(F/H)62AA.

Corrections

- Displays warning message of externally modified source file when compiling through CTRL+F7 shortcut or Compile button.
- Do not delete the linker input section (entire row) if the Section Name cell is selected and the ESC button is pressed at the same time.
- Fixed a possible data breakpoint inconsistency after setting/removing regular breakpoints.
4.17 Summary of changes in release 4.1.6

New features

Advanced debug machine (advanced breakpoints) available on STice for all STM8 microcontrollers.

STice, STM8-ICD-SWIM and the STM8 simulator support the following additional microcontrollers: STM8S903F3, STM8AF6226, STM8AF6246, STM8AF6248, STM8AF6266, STM8AF6268.

Improvements

Reduced duration of Start Debug on workspaces with lots of files and directories.

4.18 Summary of changes in release 4.1.5

New features

For Cosmic lkf file management:

- Non-automatic mode restored as Custom mode (this mode was removed in STVD release 4.1.4).
- Addition of Semi-automatic mode where STVD manages only parts of the linker file, delimited by reserved markers.

Corrections

ENUMTYPE(BYTE) can now be selected with the Raisonance compiler.

4.19 Summary of changes in release 4.1.4

New features

- Support for data watchpoints on STice.
- Support for write data watchpoints on Simulator.

Improvements

- For STM8 Raisonance toolset:
  - Manages EEPROMSTART and EEPROMSIZE directives (version 2.25 or later).
  - Uses OMF2HEX converter instead of OHST7.
- For Cosmic toolset:
  - Manages ‘+fast’ directive.
  - Lkf file management enhancement: some lkf file sections are reserved for STVD and are updated even if Auto mode is disabled. Automatic management may be
disabled by removing section delimiters. Custom modifications are allowed in the `lkf` outside reserved sections and when the ‘auto’ mode is disabled.

- Symbolic disassembly works for peripheral registers defined in Cosmic include files.

- New method for list file generation with absolute addresses by ST Assembler-Linker list file post-processor named `abslist`.
- Regression fix on Simulator after renaming of `periph.ini` file in STVD-4.1.3.
- Regression fix on STice ‘unable to load workspace’ when starting debug out of workspace.
- Bug fixed: some ‘intrusive read’ registers are now declared in `stm8_periph.ini` for STM820x and STM8L15x microcontrollers.

4.20 Summary of changes in release 4.1.3

New features
Support of STM8L15x microcontrollers on STVP and STVD STice, Simulator and SWIM debug instruments.

Improvements
Improvement in this release is that EEPROM data is emulated on STice for STM8L101x3 microcontrollers.

4.21 Summary of changes in release 4.1.2

New features
Support of ST7FMC2R9 and ST7FMC2S9 on EMU3

Improvements
- STM8 coverage/profiling on STice is functional up to 24 MHz.
- STM8 data EEPROM emulated on STice, except on STM8L101x microcontrollers.
- Peripherals can be frozen on the STice while the user application is stopped, according to the user’s selected MCU option.
- User can now choose the debugger behavior on stop debug with a SWIM debug instrument:
  - either stop the application and leave the SWIM active on the microcontroller (only way to escape is a power on reset),
  - or restart the application with SWIM Off and software breakpoints removed (provided that the communication with the microcontroller is functional).
- Possibility to run the Raisonance code compressor (if available in the Raisonance toolset installed version).
Corrections

- STM8 coverage/profiling on STice is functional even when there are simultaneous read and write accesses.
- With the SWIM debugger, the Halted status has been replaced by the No Access status, reached when the microcontroller is executing Halt, Wfi, Wfe instructions or protected code.

4.22 Summary of changes in release 4.1.1

New features
Support of new STM8 microcontrollers by STice, ICD-SWIM and STM8 simulator:
- STM8S family: 8 K and 32 K Flash
- STM8L family: 8 K Flash

Improvements
- STM8 data EEPROM is now writable (as a RAM) by the application on STice.

Corrections
- Fixed bug related to unexpected NEM breaks on STice (RETF, IRET when crossing a 64 Kbyte boundary).
- Fixed bug related to wrong location in disassembly window on STM8 when stopping on code deprived of debug information.
- Correction of bad option description for ST7FL3x microcontrollers on ST7-ICD-ICC target.

4.23 Summary of changes in release 4.1.0

New features
New features in this release include:
- STice: coverage/profiling on STM8A and STM8S microcontrollers, with core running up to 12MHz.
- ICD-SWIM: support of ST-Link board as SWIM dongle.
Improvements

Improvements in this release include:

- Up to 4 ‘memory’ windows may be opened simultaneously.
- Management of global variables automatic relocation for Raisonance toolset.
- Added *.bit section in Cosmic link script file.
- Main.asm and mapping.inc files automatic creation during creation of Assembler/Linker project.
- Enhanced performance of find in files function.
- SWIM communication enhancements on STice (SWIM dongle).
- SWIM debugger: Flash and data EEPROM RASS protections are restored to user's state before running user's application.
- Stack location adjusted to datasheet on STM8A and STM8S microcontrollers.
- On simulator CPU frequency is now entered by the user. Default value is 16 MHz.

Corrections

Corrections in this release include:

- User defined option in ST Assembler/Linker project.
- Project was not rebuilt after suppression of project source file(s).
- Fixed bug related to +e directive of Cosmic assembler (Assembler/Listing/Generate an Errors Log File).
- STM8 Raisonance Builder: CODESTART directive address includes Vectors area.
- Fixed issue with RLink SWIM when the microcontroller in Halt mode.
- Fixed potential issue in identification procedure of a microcontroller in SWIM hotplug mode.

4.24 Summary of changes in release 4.0.1

New features

This release provides support for the STM8S207x and STM8S208x families of microcontrollers.

Improvements

Improvements in this release include:

- Parallel port driver installation/removal is now subject to user’s agreement.
- With the Cosmic C compiler:
  - Boolean variables are now properly initialized: the .bit section is automatically generated in the linker input file
  - Debug information for function parameters is improved for STM8 microcontrollers.
- With the Raisonance toolset, the number of optimization levels is reduced to 4 for greater ease of use.
- STM8A AFREMAP options are managed on STice.
Corrections

Corrections in this release include:

- When a source file is modified while in Debug mode, the debug session is now properly managed.
- STice trace timestamp overflow event is properly managed.
- When a debug session is stopped, SWIM communication is switched off on the microcontroller side.

4.25 Summary of changes in release 4.0

New features

STVD release 4.0 provides support for the following additional microcontrollers:

- Simulator
  - STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, STM8AF51A9, STM8AF51AA
  - STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA

- In-circuit debugging through SWIM
  - STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, STM8AF51A9, STM8AF51AA
  - STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA

- STice
  - STM8AF5168, STM8AF5169, STM8AF5178, STM8AF5179, STM8AF5188, STM8AF5189, STM8AF5198, STM8AF5199, STM8AF519A, STM8AF51A8, STM8AF51A9, STM8AF51AA
  - STM8AF6166, STM8AF6168, STM8AF6169, STM8AF6176, STM8AF6178, STM8AF6179, STM8AF6186, STM8AF6188, STM8AF6189, STM8AF6198, STM8AF6199, STM8AF619A, STM8AF61A8, STM8AF61A9, STM8AF61AA

STVD release 4.0 also provides support for:

- The Cosmic C toolset for STM8
- The Raisonance C toolset for STM8
- STice advanced emulation system

The full set of configuration features are available from the Project Settings interface.
Improvements

Improvements in this release include:

- The Cosmic C compiler setting for the memory model is now consistent with the startup file. For example, in an ST7 project, selecting the Long Stack memory model will trigger crtsx.st7 at startup.
- In the Cosmic Linker, for all toolsets, the Default button now sets correctly the default startup file according to the memory model. For example, in an STM8 project, if the current memory model is Long Stack, clicking on the Default button will set the startup file to crts1.sm8, which is the default value for that model.

Corrections

This release includes a number of small corrections that occurred only in marginal configurations of use.

4.26 Summary of changes in release 3.5.0

New features

STVD7 release 3.5.0 provides support for the following additional microcontrollers:

- Simulator
  - ST7FOXK1, ST7FOXK2, ST7FOXF1, ST7FOXU0, ST7FLUS5, ST7FLU05, ST7FLU09, ST7FLI49K2T6, ST7FLI49K2B6
- In-circuit debugging
  - ST7FOXK1, ST7FOXK2, ST7FOXF1, ST7FLI49K2T6, ST7FLI49K2B6

STVD7 release 3.5.0 also provides support for the Raisonance C toolset. The full set of configuration features is available from the Project Settings interface.

Improvements

Improvements in this release include:

- The Find in Files feature now proposes the path of the previous search, except if the current project has changed, in which case the path of the current project is proposed.
- The list of microcontrollers in the MCU Selection dialog box is dependent on the toolset: only the microcontrollers supported by the selected toolset are listed.
- Simulator provides full support for all new features of Lite1B auto-reload timer:
  - forcing of counter 1 and counter 2 overflow
  - separate break for counter 1 and counter 2
  - one pulse mode on PWM2 and PWM3
- For Lite49M auto-reload timer, Simulator supports distinct output compare interrupt and input capture interrupt.
- For Lite49K auto-reload timer, Simulator supports the second break pin.

Corrections

With simulator, instructions performing a read access to a port data register with some of the port pins configured as inputs are now correctly executed.
This release also includes a number of small corrections that occurred only in marginal configurations of use.

4.27 Summary of changes in release 3.4.0

New features

STVD7 release 3.4.0 provides support for the following additional microcontrollers:

- ST7MDT40-EMU3 emulators
  - ST7FLITE54K4/S4, ST7FLITE55C4
- Simulator
  - ST7FLITE54K4/S4, ST7FLITE55C4, ST7FLITE49M
- In-circuit debugging
  - ST7FLITE54K4/S4, ST7FLITE55C4, ST7FLITE49M

Improvements

Improvements in this release include:

- A new option on the Edit/Debug tab allows user to select the behavior of the system before building a project or before starting a debug session. User can either request to be prompted to save his files (Prompt before Saving Files option), or select to save files automatically (Automatic File Saving option).
- In the project settings window, the Linker tab/general category options now show the list of linked standard libraries.
- In the project settings window, STVD7 prompts the user for confirmation when a section is created in the linker/input that has the same name as an existing section. Previously this operation was not allowed.
- When the selected MCU is changed, user gets a message warning him that some of the build options might be replaced by the default settings for that type of circuit.
- The menu option and window title Emulation Discrepancies has been renamed and is now called Debugging Discrepancies.
- The debugging discrepancies feature has been extended to the simulator. For some circuits, the Debugging Discrepancies window lists the limitations pertaining to the simulated circuit.
- Support for booleans with the Cosmic C compiler. There is however, a limitation because boolean variables are not properly initialized.
- In the simulator, user can generate interrupt requests from the I/O stimulation window. This is done by changing the value of the IRQx pseudo pin. This feature is useful for debugging code that manages non-simulated peripherals.
Corrections

Corrections in this release include the following major fixes:

- The update of the STM Parallel driver version 1.2 (a driver used by some third-party tools and installed with STVD7 prior to version 2.0) under Windows XP Service Pack 2, no longer causes a crash during installation.
- Initial project settings are properly restored when Cancel is done after selecting Default settings.
- Link file modifications are automatically taken into account in the list of build dependencies.
- When opening a project, a warning message is displayed when a file that was part of the project no longer exists. This message is no longer displayed each time the project is opened.
- The following problems related to wrap executable projects have been corrected:
  - The Export Makefile option is disabled, thus avoiding a system crash.
  - The path name for the executable file is now relative to the project folder, which makes it easier to transfer projects from one computer to another.
  - When creating a wrap executable project, the interrupt vector file is no longer added.

When starting a debugging session, a message was displayed to indicate that the debugging information could not be found. This message is no longer displayed.

4.28 Summary of changes in release 3.3.4 (April 2007)

New features

STVD7 release 3.3.4 provides support for the following additional microcontrollers:

- ST7MDT10-EMU3 emulators
  - ST7FLITEU0(2/5/9)
- Simulator
  - ST7FLITEU0(2/5/9), ST72324LS(2/4), ST72324BLS(2/4)
- In-circuit debugging
  - ST7FMC2S7, ST7FLITEUSICD (ST7FLITEUS 16-pin package specially designed for in-circuit debugging), ST7FLITEU0ICD (ST7FLITEU0 16-pin package specially designed for in-circuit debugging)

Improvements

In this release, STVD7 checks whether a build is required before starting a debug session.

Corrections

Corrections in this release include the following major fixes:

- In the main configuration window the Modify Area did not work properly in STVD7 3.3.3. This regression compared with STVD7 3.3.2 is fixed in this release.
- The linker file is now included in the build dependencies list for non-automatic Cosmic projects.
4.29 Summary of changes in release 3.3.3 (December 2006)

New features

STVD7 release 3.3.3 provides support for the following additional microcontrollers:

- ST7MDT20M-EMU3 emulators
  - ST7321M(6/9)
- ST7MDT40-EMU3 emulators (previously called ST7MIDI-EMU3)
  - ST72340S(2/4), ST72344S(2/4), ST72345C4
- ST7MDT50-EMU3 emulators
  - ST7MC2S7
- ST7MDT20-DVP3 emulators
  - ST72321M(6/9), ST7FLITEUS(2/5)
- Simulator
  - ST72321M(6/9), ST72321BM(6/9), ST72325C(6/7/9), ST72325S(4/6), ST72340S(2/4), ST72344S(2/4), ST72345C4
- In-circuit debugging
  - ST7340S(2/4), ST72344S(2/4), ST72345C4

Improvements

Improvements in this release include:

- A template for the main source file (main.c) is provided when user creates a new workspace and project.
- For Cosmic C compiler users, an additional column in the Linker Input table allows you to enter options for custom linker sections.
- For Cosmic C compiler users, the Linker Startup File selection list now offers the option None. When selected, the default startup routine is not used. You must create your own routine.
- Changes to vector file and microcontroller selection in Project Settings are now applied to all project configurations.

Corrections

Corrections in this release include the following major fixes:

- For Cosmic C compiler users, when the +split option is checked in the C Compiler Optimizations list in the Project Settings window, it is correctly added to the command line displayed at the bottom of the window.
- For Cosmic C compiler users, checking the verbose option (-v) in the C Compiler Listings options applies the option to listings and to optimizations, thus avoiding inconsistency in settings that could occur previously.
- Under certain conditions, icons disappeared from menus and menu bars in the main window. This problem is corrected.
- The vector file template (vector.c) is now generated only when the project is created. Its contents are no longer impacted by changes in the project settings.
4.30 Summary of changes in release 3.3.2

New features

- A check box, **Show selected target notification at start of debug** has been added to the Debug Instrument Settings (**Debug Instrument>Target Settings**). Checking this option resets the check box in the **Target Selection** pop-up, so that the notification is displayed at the start of the debug session.

- The following register window name changes have been implemented:
  - **ST7 Registers** renamed to **Core Registers**
  - **ST7 Peripheral Registers** renamed to **Peripheral Registers**

Plus support for the following microcontrollers:

- ST7MDT10-EMU3 emulators
  - ST7LITEUS (STVD7 3.3.2 with Patch 2)
- ST7MDT20J-EMU3 emulators
  - ST72321BK6, ST7232AJ(1/2)
  - ST7232xBLx6 (STVD7 3.3.2 with Patch 2)
- ST7MDT20M-EMU3 emulators
  - ST72321B(R6/R7/R9/AR6/AR7/AR9)
- ST7MDTU3-EMU3 emulators
  - ST7260(E1/E2/K1/K2), ST7263B(D6/E1/E4), ST7263BK2U1 (QFN40 package)
- ST7MDT20-DVP3 emulators
- In-circuit debugging (EMU3, DVP3 and RLink)
  - ST7FLITE1(0/5/9), ST7FLITE0(2/5/9), ST7FLITES(2/5), ST72260G1, ST72262(G1/G2), ST72264(G1/G2), ST72F321B(J6/J7/J9/R6/R7/R9/AR6/AR7/AR9)
  - ST7FLITEUS, ST72F34xZ (STVD7 3.3.2 with Patch 2)
- Simulator

Corrections

Corrections in this release include the following major fixes:

- Corrects errors that occurred in the **Plotter** window when importing VCD files (**File>Import...**) and adding new items to a plot (**Project>Add New Items...**). In previous versions using these features resulted in an **"Parser not found"** error.

- Values for selected variables are correctly displayed in the **Local Variables** window. Corrects problem that appeared in STVD7 releases 3.3.0/3.3.1.

- Corrects false warning message that sometimes occurred when saving a workspace or entering a debug session after initial creation of a workspace.

Correction implemented with Patch 2:

- Corrects an error that occurred when in-circuit debugging ST7FLITE1x microcontrollers.
4.31 Release 3.3.0/3.3.1 (January/February 2006)

New features

- **Plotter** now includes improved navigation and display controls, configurable signals, multiple configurable position markers, multiple configurable display tabs, item selection for printing and import/export of plotted data in VCD format.
- The **Linker** tabs of the **Project Settings** interface now allow creation of user defined memory segments and customization of the assignment of code sections to memory segments.
- Support of Raisonance **RLink** for both debugging and programming. After installing STVD7, RLink users must install the RLink USB driver. To do this, before launching STVD7, select **Start>Programs/ST Toolset>Setup>Install RLink driver**.
- Modification to display LEDs in the **MCU Selection** window. GREEN = MCU supported, YELLOW = Supported in Beta and GRAY = Not supported
- **ST7MDT10-EMU3** emulator support of ST7L15F1, ST7L19F1, ST7L34, ST7L38
- **ST7MDT10-DVP3** emulator support of ST7L15F1, ST7L19F1, ST7L34, ST7L38
- **In-Circuit Debugging** (EMU3, DVP3 and RLink) support of ST7L15F1, ST7L19F1, ST7L34, ST7L38
- **Simulator** support of ST7232AK(1/2), ST72325AR6

Corrections

- **Find** feature in the Editor windows modified so that search loops after reaching the top or bottom of the document. In preceding versions, the search stopped at the end of the document and no “end of the file” message was displayed.
- Corrects possible programming error sometimes occurring during in-circuit debugging of HDFlash MCU if code section crossed over boundary between two HDFlash sectors.

4.32 Release 3.2.1 (October 2005)

New features

- **ST7-EMU3** improvements include: ST7MDT10-EMU3 support of ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7MDT20J-EMU3 support of ST72325C(4/6), ST7MDT50-EMU3 support of ST7MC1K6, ST7MDI-EMU3 support of ST72340J(2/4), ST72340K(2/4), ST72344J(2/4), ST72344K(2/4), ST72345N4.
- **ST7-DVP3** improvements include: ST7MDT10-DVP3 support of ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST7MDT20-DVP3 support of ST72325C(4/6), ST7MDT25-DVP3 support of ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), ST72361R(4/6/7/9), ST72561AR(4/6/7/9), ST72561J(4/7), ST72561K(4/7), ST72561R(4/7)
- **In-Circuit Debugging** (EMU3 and DVP3) improvements include support of ST7FLIT10BF(0/1), ST7FLIT15BF(0/1), ST7FLIT19BF(0/1), ST7FLIT10BY(0/1), ST7FLIT15BY(0/1), ST7FLIT19BY(0/1), ST72F325AR(6/7/9), ST72F325J(7/9),
Information on major previous releases


- **Simulator** improvements include support of ST7LIT10BF(0/1), ST7LIT15BF(0/1), ST7LIT19BF(0/1), ST7LIT10BY(0/1), ST7LIT15BY(0/1), ST7LIT19BY(0/1), ST72325AR(6/7/9), ST72325J(4/6/7/9), ST72325K(4/6), ST72325R(7/9), ST72340J(2/4), ST72340K(2/4), ST72344J(2/4), ST72344K(2/4), ST72345N4, ST72361AR(4/6/7/9), ST72361J(4/6/7/9), ST72361K(4/6/7/9), ST72361R(4/6/7/9)

4.33 **Release 3.2.0 (December 2004)**

**New features**

- New **Editor** features including folding of source code, brace matching, highlighting and auto completion of language specific key words, and function prototype tips for Assembly source files.
- Workspace now allows creation of **subfolders within folders** in the Workspace window.
- Improved display in **Disassembly** window.
- **Simulator** improvements include: plotter outputs plot information in text format to VCD file, support of ST7LITE3(0/5/9), ST7L(05/09/35/39)
- **ST7-EMU3** improvements include: support for ST7LITE3(0/5/9), ST7L(05/09/35/39), ST72325, **MSCI Tools** window displays the memory space dedicated to the ST7 Mass Storage Communication Interface and its registers for ST7267 (ST7MDTU7-EMU3).
- **ST7-DVP3** supports ST7LITE3(0/5/9), ST7L(05/09/35/39) and ST72325
- **In-Circuit Debugging** (EMU3 and DVP3) improvements include: support of ST72F325J(4/6), ST72F325K(4/6), ST7267, ST7FDALI, ST7FLITE3(0/5/9), ST7FL3(5/9), ST7FMC1K(2/4), ST7FMC2S(4/6), ST72F325J(4/6), ST72F325K(4/6), **MSCI Tools** window for ST7267 (with EMU3 and DVP3)

**Corrections**

- The Block Selection tool allows cut, copy or delete of selections.
- Improved project file format allows automatic conversion of project files and generation of a backup file *.bak.
- Library file path can now be added from the **Directories** tab of the **Tool Options** window (Tools>Options).
- Fixes problems related to use of macros in the build interface.
- Corrects crashes that occurred when debugging some applications in projects that had been created by ‘wrapping an existing executable file’.
- F4 is no longer used to navigate in bookmarks.
- For a register stored at 0x00, viewing in the Watch window no longer returns an unknown address error.
4.34 Release 3.1.0/3.1.1 (December 2004)

- Support for In-Circuit Debugging (ICD) with ST7-DVP3 Emulators (Rel. 3.1.1).
- Support for ST7MDT25-DVP3 Emulator for ST72561 (Rel. 3.1.1).
- Support for ST7MDTU3-EMU3 Emulator for the ST72F63.
- Generate Support File allows automatic collection of error logs.
- Input Stimulator allows definition of periodic input signals (View>Input Stimulation).
- Optimizes builder performance when assessing dependencies for large projects or with server-based compiler and a floating license.
- ST7-DVP3 improvements include: correction of errors occurring with fill memory on Special Function Registers (SFRs), allowing writing to EEPROM by typing the values in the Memory window, I2C registers no longer mapped as “Non-Existent Registers.”
- ST7-EMU2 improvements include: resolution of crashes occurring on some machines after launching a hardware test while debugging an application, then ending the debug session.
- ST7-ICD improvements include saving of trace configuration with the workspace and restored at Start Debug.

4.35 Release 3.0.1 (October 2004)

- EEPROM now simulated but with discrepancy in write time compared to MCU.
- Conversion feature for workspaces *.wsp created by STVD7 prior to version 3.0.
- Highlighting of debug instruments that support the selected microcontroller.
- Resolves installation problems occurring with some configurations of Windows XP.
- Resolves option transfer problems occurring when the user changed the MCU selection in the project settings on a non-active build configuration.
- ST7 Assembler Linker, -sym option is added to the assembler command line by default.

4.36 Release 3.0 (April 2004)

- User Interface improvements include: Project Settings window for customizing the building of the application when using ST7 Assembler-Linker, Cosmic C or Metrowerks C toolsets, MCU selection integrated in the Project Settings interface, single installation of STVD7 supports the full range of debug configurations and hardware (Simulator, ICD, DVP3, EMU3 and EMU2), include files in C and Assembler that define and declare the peripheral registers for each ST7, programming interface based on STVP7 supporting socket, in situ and in-circuit programming modes and hardware, two stepping modes that allow choice of whether or not to enter interrupts that may occur during stepping (Debug Instrument>Stepping Modes).
- ST7-Simulator improvements include: graphic interface to control sending of stimulus signals to the input pins of the simulated target microcontroller, plotter interface to graph the evolution of variables, registers and signals.
- DMA, IT and Stack memory access events are now included in the pull down list of configurable memory events in the Advanced Breakpoints window for ST7-EMU3.
## 5 Revision history

Table 2. Document revision history

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>23-Nov-2006</td>
<td>1</td>
<td>Initial release for STVD7 3.3.3.</td>
</tr>
<tr>
<td>20-Apr-2007</td>
<td>2</td>
<td>Release for STVD7 3.3.4.</td>
</tr>
<tr>
<td>20-Aug-2007</td>
<td>3</td>
<td>Release for STVD7 3.4.0.</td>
</tr>
<tr>
<td>6-Dec-2007</td>
<td>4</td>
<td>Release for STVD7 3.5.0.</td>
</tr>
<tr>
<td>11-Dec-2007</td>
<td>5</td>
<td>Update for STVD7 3.5.0.</td>
</tr>
<tr>
<td>06-Mar-2008</td>
<td>6</td>
<td>Update for STVD 4.0.</td>
</tr>
<tr>
<td>13-May-2008</td>
<td>7</td>
<td>Update for STVD 4.0.1.</td>
</tr>
<tr>
<td>9-Jun-2008</td>
<td>8</td>
<td>Additional updates for STVD 4.0.1.</td>
</tr>
<tr>
<td>27-Nov-2008</td>
<td>9</td>
<td>Update for STVD 4.1.0.</td>
</tr>
<tr>
<td>11-Dec-2008</td>
<td>10</td>
<td>Additional updates for STVD 4.1.0.</td>
</tr>
<tr>
<td>26-Feb-2009</td>
<td>11</td>
<td>Update for STVD 4.1.1</td>
</tr>
<tr>
<td>11-May-2009</td>
<td>12</td>
<td>Update for STVD 4.1.2: added new MCUs in Stice advanced emulation system on page 7, ST7-EMU3 emulators on page 9, STM8-ICD-SWIM on page 8 and STM8 Simulators on page 11. Updated Section 3.4: Known problems/limitations for STice targets.</td>
</tr>
<tr>
<td>07-Sep-2009</td>
<td>13</td>
<td>Update for STVD 4.1.3: added new MCUs in Stice advanced emulation system on page 7, STM8-ICD-SWIM on page 8 and STM8 Simulators on page 11. Updated Section 3.5: Known problems for STM8-ICD-SWIM targets.</td>
</tr>
<tr>
<td>18-Dec-2009</td>
<td>14</td>
<td>Update for STVD 4.1.4: added new MCUs in Stice advanced emulation system on page 7, STM8-ICD-SWIM on page 8 and STM8 Simulators on page 11. Modified Section 1.3 and Section 1.5.</td>
</tr>
<tr>
<td>01-Apr-2010</td>
<td>15</td>
<td>Update for STVD 4.1.5: Modified Section 2.1.</td>
</tr>
<tr>
<td>01-Jul-2010</td>
<td>16</td>
<td>Update for STVD 4.1.6: Modified Section 2.1. Added STM8AF6226, STM8AF6246, STM8AF6248, STM8AF6266, STM8AF6268 and STM8S903F3 in: Stice advanced emulation system on page 7, STM8-ICD-SWIM on page 8 and STM8 Simulators on page 11. Modified Section 1.3, Section 1.4 and Section 1.5.</td>
</tr>
<tr>
<td>Date</td>
<td>Revision</td>
<td>Changes</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>23-Sep-2010</td>
<td>17</td>
<td>Update for STVD 4.2.0: Modified Section 2.1.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added STM8L151C8, STM8L151M8, STM8L151R8, STM8L151R6, STM8L152C8,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STM8L152M8, STM8L152R8, STM8L152R6, STM8L162M8, STM8L162R8, STM8A(F/H)5268,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STM8A(F/H)5269, STM8A(F/H)5288, STM8A(F/H)5289, STM8A(F/H)528A,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STM8A(F/H)52A8, STM8A(F/H)52A9, STM8A(F/H)52AA, STMA(F/H)6269, STMA(F/H)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6268, STMA(F/H)6288, STMA(F/H)6289, STMA(F/H)628A, STMA(F/H)62A8,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>STMA(F/H)62AA in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STice advanced emulation system on page 7,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8-ICD-SWIM on page 8 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8 Simulators on page 11.</td>
</tr>
<tr>
<td>22-Feb-2011</td>
<td>18</td>
<td>Update for STVD 4.2.1:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added support for the STM8L101F1 and Windows 7.</td>
</tr>
<tr>
<td>07-Apr-2011</td>
<td>19</td>
<td>Update for STVD 4.2.1 patch1:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– Added support for STM8L151x2/3 in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STice advanced emulation system on page 7,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8-ICD-SWIM on page 8 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8 Simulators on page 11.</td>
</tr>
<tr>
<td>26-May-2011</td>
<td>20</td>
<td>Update for STVD 4.2.1 patch2: Fixed build issues when time zone GMT-</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x(x&gt;0) with STVD-4.2.1 and STVD-4.2.1 patch1. Replaces patch1.</td>
</tr>
<tr>
<td>03-Oct-2011</td>
<td>21</td>
<td>Update for STVD 4.3.0:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added support for STM8S003F3/K3, STM8S005C6/K6, STM8S007C8 in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8-ICD-SWIM on page 8 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8 Simulators on page 11.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added support for STM8S208M8 in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STice advanced emulation system on page 7,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8-ICD-SWIM on page 8 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8 Simulators on page 11.</td>
</tr>
<tr>
<td>19-Jan-2012</td>
<td>22</td>
<td>Update for STVD 4.3.1:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Added support for STM8TL53C4 and STM8TL53G4 in:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8-ICD-SWIM on page 8 and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STM8 Simulators on page 11.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>– STice advanced emulation system on page 7.</td>
</tr>
</tbody>
</table>
### Table 2. Document revision history (continued)

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Changes</th>
</tr>
</thead>
</table>
| 05-Jul-2012| 23       | Update for STVD 4.3.2:  
Added new features and corrections in Changes in the release notes for STVD 4.3.2 on page 1.  
Added support for STM8S207K8, STM8TL52G4, STM8TL52F4, STM8TL53F4 in Simulators on page 11.  
Added support for STM8S207K8, STM8TL52G4, STM8TL52F4, and STM8TL53F4 in ST8-ICD-SWIM on page 8.  
Added support for STM8S207K8, STM8TL52G4, STM8S003F3/K3, STM8S005C6/K6, and STM8S007C8 in STice advanced emulation system on page 7.  
Removed STM8AHx2xx order codes in STice advanced emulation system on page 7, ST8-ICD-SWIM on page 8, and Simulators on page 11. |
| 28-Sep-2012| 24       | Added new features in Changes in the release notes for STVD 4.3.2 on page 1.  
Added support for STM8L051F3, STM8L052C6 and STM8L052R8 in:  
  - STice advanced emulation system on page 7  
  - ST8-ICD-SWIM on page 8  
  - STM8 Simulators on page 11. |
| 15-Jan-2013| 25       | Update for STVD 4.3.3:  
  - One correction placed in Changes in the release notes for STVD 4.3.3 on page 1 and Section 2: What is new in STVD Release 4.3.3?  
  - Replaced STM8AF6226 by STM8AF6226TxSSS in the lists of supported devices Section 2.2.1, Section 2.2.2 and Section 2.2.8. |
| 02-Jul-2013| 26       | Update for STVD 4.3.4:  
  - Added new features and corrections in Changes in the release notes for STVD 4.3.4.  
  - Added STM8AL31xx and STM8AL3Lxx in the list of supported devices Section 2.2.2: ST8-ICD-SWIM and Section 2.2.8: Simulators.  
Removed STM8TL53C4, STM8TL53G4 and STM8TL52G4 from the list of supported MCUs in Section 2.2.1: STice advanced emulation system. |
| 04-Dec-2013| 27       | Update for STVD 4.3.5:  
  - Added new features and corrections in Changes in the release notes for STVD 4.3.5.  
  - Added Windows 8 and related notes in the list of operating system supported by simulator, Stice, RLink and ST-LINK in Section 1.1: Host PC system requirements.  
  - Added STM8AF6223, STM8AF6223PxA and STM8AF6226 in the list of supported devices Section 2.2.2: ST8-ICD-SWIM and Section 2.2.8: Simulators.  
  - Added new limitations in Section 3.3: Known problems/limitations for debug interface. |
| 26-Aug-2014| 28       | Updated STVD 4.3.6:  
  - Added new features and corrections in Introduction on page 1.  
Added STM8AF5286 on Section 2.2.1: STice advanced emulation system, Section 2.2.2: ST8-ICD-SWIM and Section 2.2.8: Simulators. |
**Table 2. Document revision history (continued)**

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Changes</th>
</tr>
</thead>
<tbody>
<tr>
<td>23-Oct-2014</td>
<td>29</td>
<td>Added new MCU STM8AF52A6 to STVD 4.3.6</td>
</tr>
<tr>
<td>23-Sep-2015</td>
<td>30</td>
<td>Release for STVD version 4.3.7: Updated Section : Changes in the release notes for STVD 4.3.7, Section 2: What is new in STVD Release 4.3.7? and Section 3: Known problems/limitations.</td>
</tr>
<tr>
<td>26-Oct-2015</td>
<td>31</td>
<td>Release for STVD version 4.3.8: Updated Section 2.1: Summary of changes in Release 4.3.8.</td>
</tr>
</tbody>
</table>
| 05-Apr-2016| 32       | Release for STVD version 4.3.9:  
– Added features in Section 2: What is new in STVD Release 4.3.9?  
– Added STM8AL31E89, STM8AL31E8A, STM8AL3LE89 and STM8AF6223A in Section 2.2.2: STM8-ICD-SWIM and STM8AL31E89, STM8AL31E8A, STM8AL3LE89 and STM8AL3LE8A and STM8AF6223A in Section 2.2.8: Simulators. |
| 11-Jan-2017| 33       | Release for STVD version 4.3.10: correction described in Introduction.                                                                                                                                  |
| 09-Jun-2017| 34       | Release for STVD version 4.3.11:  
– Added new feature in Introduction  
– Added Section 2: What is new in STVD release 4.3.11?  
– Added STM8L152K8 and STM8S001J3 in Section 2.2.2: STM8-ICD-SWIM and in Section 2.2.8: Simulators |
| 15-Nov-2017| 35       | Release for STVD version 4.3.12:  
– Added What is new in STVD release 4.3.12?  
– Added STM8L050J3 and STM8L001J3 in Section 2.2.2: STM8-ICD-SWIM and in Section 2.2.8: Simulators |
IMPORTANT NOTICE – PLEASE READ CAREFULLY

STMicroelectronics NV and its subsidiaries (“ST”) reserve the right to make changes, corrections, enhancements, modifications, and improvements to ST products and/or to this document at any time without notice. Purchasers should obtain the latest relevant information on ST products before placing orders. ST products are sold pursuant to ST’s terms and conditions of sale in place at the time of order acknowledgement.

Purchasers are solely responsible for the choice, selection, and use of ST products and ST assumes no liability for application assistance or the design of Purchasers’ products.

No license, express or implied, to any intellectual property right is granted by ST herein.

Resale of ST products with provisions different from the information set forth herein shall void any warranty granted by ST for such product.

ST and the ST logo are trademarks of ST. All other product or service names are the property of their respective owners.

Information in this document supersedes and replaces information previously supplied in any prior versions of this document.

© 2017 STMicroelectronics – All rights reserved